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What is OpenType?
OpenType is a cross-platform font file format introduced by Adobe and Microsoft in the late 1990s. OpenType is an extension of the TrueType sfnt format that
can have either Type 1 (“PostScript®”) or TrueType
font outlines, and supports additional typographic and
linguistic features. OpenType fonts containing Type 1
outlines have an .otf file name suffix, while those with
TrueType outlines may have a .otf, .ttf or .ttc file name
suffix. OpenType fonts with Type 1 outlines use the
“Compact Font Format” or CFF to store those outlines—
the same way Type 1 fonts are stored in Adobe PDF files.
This user guide deals primarily with the installation and
use of OpenType CFF fonts.
OpenType fonts may include an expanded character
set and layout features to provide richer linguistic support and/or advanced typographic control. OpenType
fonts from Adobe with support for central European
(CE) languages can be distinguished by the word “Pro,”
which is part of the font name and appears in application font menus. OpenType fonts that do not contain
central European language support are labeled “Standard,” and are designated by an “Std” suffix in the fonts’
menu names. Although Adobe “Pro” fonts frequently
include extended typographic support, it is not a
requirement, and “Std” fonts may also have extensive
typographic features.
All OpenType fonts from Adobe can also be installed
and used alongside Type 1 (“PostScript”) and TrueType
fonts; as part of converting the Adobe Type Library to
OpenType, the fonts’ names were changed so as to avoid
conflicts.
One Cross-Platform Font File
All OpenType fonts use a single font file for all of their
outline, metric, and bitmap data (if any), making file
management simpler. The file names for OpenType fonts
from Adobe are clearly descriptive. In addition, the same
font file works on Macintosh and Windows computers,
Macintosh

Windows

improving cross-platform portability for documents.
Although the same font file works on multiple plaforms,
different platforms have different ways of handling font
menu names. In particular, “typical” Windows applications do not show all fonts as separate entries in their
font menus. However, many Adobe applications use a
consistent approach to font menus on all platforms. See
the OpenType readme for more details.
Better Language Support
Based on Unicode, an international multi-byte character encoding that covers virtually all of the world’s
languages, OpenType fonts can make multilingual
typography easier by including multiple language character sets in one font. All normal alphabetic OpenType
fonts from Adobe include the standard range of Latin
characters used throughout the western world, and
several international characters, including the euro currency symbol (), “estimated” (℮), and litre (ℓ). Adobe’s
“Pro” fonts add a full range of accented characters to
support central and eastern European languages, such
as Turkish and Polish. Many of Adobe’s Pro fonts also
support Cyrillic and Greek languages in the same font,
and some support Vietnamese and others as well.
Advanced Typography with OpenType Pro fonts
OpenType fonts may also contain up to 65,536 glyphs,
unleashing exciting typographic capabilities. Many
non-standard glyphs, such as oldstyle figures, true small
capitals, fractions, swashes, superiors, inferiors, ornaments, titling letters, contextual and stylistic alternates,
beginning and ending letterforms and a full range of
ligatures may also be included in a single font. In the
past, a typical Western Type 1 font was limited to 256
encoded glyphs, forcing users to install and manage two
or more related fonts in order to access “expert” or other
supplemental characters. OpenType significantly simplifies font management and the publishing workflow by
ensuring that all of the required glyphs for a document
are contained in one cross-platform font file throughout
the workflow.
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Historically, some of the highest-quality typefaces have
had different designs for different print sizes. Called
“opticals” at Adobe, these variations have been optimized for use at specific point sizes. A number of
OpenType fonts from Adobe include four or five optical size variations. Although the exact intended sizes
vary by family, the typical size ranges include: caption
(6–8 point), regular (9–13 point), subhead (14-24 point)
and display (25–72 point). If present, a font intended
for even larger use (>72 point) is called “poster,” while a
“small text” font might be intended for use at about 9–10
point. Please see the optical size page on Adobe.com for
additional information.

Unbelievable
Unbelievable
Unbelievable
Unbelievable

Display
Subhead
Regular (Text)
Caption

Overall, OpenType provides richer support for the
world’s languages, more powerful typographic capabilities, better cross-platform compatibility, as well as
simplified font management. For more information on
OpenType, please refer to the Adobe web site at
http://www.adobe.com/type/opentype.

• RAM required - fonts are system resources and do
not require additional RAM beyond that needed to
run your operating system. However, having very
large numbers of fonts activated/installed may slightly
increase the memory requirements of your operating
system.
Windows
• PC using a Pentium® or compatible processor. Also
supported on older operating systems: see earlier User
Guide for details.
• Microsoft Windows® Vista®, Windows XP, Windows
2000.
• RAM required - fonts are system resources and do
not require additional RAM beyond that needed to
run your operating system. However, having very
large numbers of fonts activated/installed may slightly
increase the memory requirements of your operating
system. Be aware that using the /3GB startup switch
on Windows will reduce the memory available to the
Windows OS kernel, and may not be compatible with
having very large numbers of fonts active.

OpenType & Font Management Utilities
For further instructions on how to install OpenType
fonts with you font management application, please
refer to your font management application’s documentation.

System Requirements for
TrueType OpenType Fonts

Installing OpenType CFF Fonts
Without a Font Manager

Macintosh
• Macintosh with Intel® or PowerPC® processor
• Mac OS X

All the information required for OpenType fonts is contained in a single file with an “.otf ” suffix at the end of
the filename. This font file is a cross-platform file, and
can be installed on both the Macintosh and Windows
platforms.

Windows
• PC using a Pentium® or compatible processor
• Microsoft Windows® 3.1, 95, 98, Millennium Edition
(ME), Windows NT® 4 (SP 4), Windows 2000,
Windows XP or Windows Vista.
Note: On older versions of Mac OS, users of many Adobe
applications (including most versions of InDesign,
Illustrator and Photoshop) can use TrueType OpenType
fonts by placing them in a folder called “fonts” in the
application’s folder.

System Requirements for
OpenType CFF Fonts
Macintosh
• Macintosh with Intel® or PowerPC® processor
• Mac OS X; also supported on older operating systems:
see earlier User Guide for details.

Note that for both Mac OS and Windows, if you only
need to use the fonts in select Adobe applications (such
as InDesign, Illustrator and Photoshop), you may
place the fonts in the applications’ font folder, or in the
Adobe common font folder. This approach bypasses the
operating system altogether, so that the normal system
requirements no longer apply.
Installing on Mac OS
Mac OS X has built-in support for OpenType CFF fonts.
You do not need to install ATM Light to use fonts in the
Mac OS X native environment, only for the Classic environment. Note that only Mac OS X 10.4 and higher give
support for OpenType layout features to non Adobe
applications.
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Fonts installed under the Mac OS X native environment
will only by available to carbon and native applications
running in OS X (not Classic applications). Depending
on how they are installed, they can be accessed by (a)
any user or (b) just by an individual user.
1 Before installing your OpenType fonts, quit all active
applications.
2 Locate the folder that contains the OpenType fonts
you want to install.
If you have purchased your fonts online, they will
have been decompressed to a folder on your hard
drive. If you have purchased multiple font packages,
each will have its own folder.
3 Copy or move all the OpenType font files from their
individual font folders into either of the following
locations.
(a) <Volume>/Library/Fonts/
Note: you must be logged on as an “Administrator”
to place fonts in this location. Fonts in this location
can be used by any user.
(b) <Volume>/Users/<username>/Library/Fonts/
Note: fonts in this location can be used only by the
specified user.
The fonts are now installed and will appear in the font
menus of Carbonized or native applications.
Installing on Windows
Windows 2000, XP  and Vista have native support for
OpenType fonts; you can use the operating system’s
Fonts control panel to install or remove new OpenType
fonts. Installing your fonts on Windows 95/98, ME or
NT 4 requires ATM Light 4.1 or later.

4 Select the fonts you want to install. You can click to
select one font, Control-click to select several fonts,
or Shift-click to select a contiguous group of fonts.
5 Press the “OK” button to install the fonts.
6 Close the Fonts control panel when you are finished.
The fonts are now installed and will appear in the
font menus of your applications. NOTE: Type 1 fonts
will not be available in Windows applications that
use GDI+ or Windows Presentation Foundation.
Such applications are not common at this time.
Windows XP & Windows 2000
Like Windows Vista, Windows XP and Windows 2000
have built-in support for Type 1 and OpenType fonts
(both CFF and TrueType). Unless you wish to use multiple master fonts, ATM Light is not required on these
OSes (however, the font management features of ATM
Deluxe may still be helpful). Use the Windows Fonts
control panel to install all Type 1, TrueType, and OpenType fonts.
1 Double-click on “My Computer.” Then double-click
on the “Control Panels” icon, and then the “Fonts”
icon.
2 In the Fonts window, select the File menu, and
choose “Install New Font.”
3 Navigate to the folder that contains the fonts you
want to install.
OpenType fonts purchased online from Adobe will
be in the location where you decompressed them.
4 Select the fonts you want to install. You can click to
select one font, Control-click to select several fonts,
or Shift-click to select a contiguous group of fonts.

Windows Vista
Like Windows XP and 2000, Windows Vista has built-in
support for Type 1 and OpenType fonts (both CFF and
TrueType). ATM and multiple master fonts are not supported on Vista. Use the Windows Fonts control panel
or a third party font management utility to install all
Type 1, TrueType, and OpenType fonts. To install your
fonts with the Windows Fonts control panel:
1 Select “Control Panel” from the Start menu. Select
“Appearance and Personalization.” Select “Fonts.”
2 In the Fonts window, right-click in the list of fonts,
and choose “Install New Font.”
3 Navigate to the folder that contains the fonts you
want to install.
OpenType fonts purchased online from Adobe will
be in the location where you decompressed them.

5 Press the “OK” button to install the fonts.
6 Close the Fonts control panel when you are finished.
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The fonts are now installed and will appear in the
font menus of your applications. NOTE: Type 1 fonts
will not be available in Windows applications that
use GDI+ or Windows Presentation Foundation.
Such applications are not common at this time.

Removing OpenType CFF Fonts
Without a Font Manager
Mac OS (all versions)
1 Open the folder you installed the fonts into.
2 Drag the OpenType font files that you want to
remove out of the folder and into a non-system
folder or into the Trash.
Windows Vista, Windows XP or Windows 2000
1 Double-click on “My Computer.” Then double-click
on the “Control Panels” icon, and then the “Fonts”
icon. (If using Windows Vista, Select “Control Panel”
from the Start menu, then “Appearance and Personalization” and then “Fonts.”
2 In the Fonts window, select the Fonts you want to
remove, and choose “Delete” from the file menu. You
can click to select one font, Control-click to select
several fonts, or Shift-click to select a contiguous
group of fonts. You may also elect to copy the fonts
to another location before deleting them.

range—even though the fonts themselves may support
additional languages.
The exceptions are applications which provide their own
font and Unicode support independently of the operating systems, such as Adobe InDesign (all versions),
Photoshop (6, 7, CS, CS2, CS3, CS4) and Illustrator (CS,
CS2, CS3, CS4). In these cases, it does not matter whether
the operating system supports Unicode.
OpenType fonts which are strictly “pi” or symbolic fonts
may not have any characters in the Win-ANSI or MacRoman range. With such a pi font, if an application does
not support Unicode, then none of the characters of the
font would be accessible in the application. For more
information on such fonts, see the Pi Font Readme:
http://www.adobe.com/type/browser/pdfs/PiFontInfo.
pdf

Character access from the OS & applications
All the Unicode-encoded glyphs in an OpenType font
will show up in the Windows Vista, Windows XP, Windows 2000 or Windows NT 4, Character Map accessory,
allowing direct copying and pasting of any OpenType
glyphs into any application that supports Unicode.

3 Close the Fonts control panel when you are finished.

Unicode and Access to Symbols &
Multi-lingual Characters
Unicode and non-Unicode environments
Applications and operating systems that make use of the
Unicode standard for text processing can provide easy
access to the wide range of accented and other language
characters and special symbols which may be present in
OpenType fonts, greatly simplifying multilingual typesetting. Generally, both the application and the operating system must support Unicode to access the full
range of characters and symbols in a font. Operating
systems that support Unicode include Windows Vista,
XP, 2000 and NT 4, and Mac OS X.
When the operating system and ATM combination, or
the application, does not fully support Unicode (such as
Windows 95/98/ME or Mac OS 8 and 9), applications
will be limited in their ability to access all the characters
of an OpenType font.
In such cases, generally the application can only access
and print the basic 256 characters of western languages—the Win-ANSI (codepage 1252) or MacRoman

On Mac OS X, the Character Palette performs a similar
function. OS X users can also install and select a
Unicode keyboard that allows direct access to any
Unicode character, within most applications that
support Unicode. Note: the Character Palette may not
work consistently with Adobe applications prior to the CS
series. Also, if you experience difficulties inserting
characters, compatibility may be enhanced by having the

5

6

OpenType User Guide

same font selected in the character palette as in the
application, prior to trying to insert the desired
character(s).

simple as changing the current keyboard language setting
(if also supported by the application). This kind of “onthe-fly” keyboard switching with OpenType is supported
by Windows Vista, Windows XP,  Windows 2000, Windows NT4, and Mac OS X. Additionally, the Windows
Character Map and Mac OS Character Palette are Unicode-aware, and allow you to directly access any encoded
character in an OpenType font.

Language switching in Adobe applications
In some current-generation Adobe applications, Unicode
and language support are handled independently of the
operating system. Unicode savvy versions of InDesign,
Illustrator and Photoshop, for example, support direct
keyboard input of a wide range of languages beyond the
usual western European set, including Greek, Cyrillic,
and central and eastern European languages. For support
of Middle Eastern languages such as Arabic and Hebrew,
one must have a separate “ME” version of the application
(for CS3 and earlier versions).

Some applications offer additional options for getting
Unicode characters into the application. For example,
InDesign supports import of Unicode text files (UTF-16
encoded) and Microsoft Word for Windows files
containing Unicode characters. Additionally, as
described at more length below, InDesign and Illustrator’s Glyph Palette allows access to any glyph in the font,
even glyphs that are unencoded and not accessible in
the Windows Character Map or Mac OS Character
Palette.

Platform-specific Mac and Windows Characters
in applications
Applications with Unicode support in both their Mac and
Windows versions can access any standard character on
any platform. With these applications, you can create a
file using any character on either platform, and continue
to view and edit the same characters on the other platform. Similarly, Adobe Acrobat can view any characters
embedded in a PDF file, regardless of platform.
However, many widely used applications are not as savvy,
and can only access the standard single-byte character set
for the current operating system. With Microsoft Office,
the Windows version of the applications has long supported Unicode fully, but the Mac version did not until
Office 2004.
With these older applications, this means that even
though an OpenType font may have all the standard characters for both operating systems, the applications cannot
access the Mac-specific characters when on Windows, or
the Windows-specific characters when on the Macintosh.
Therefore, you are advised against using platform-specific
characters in such applications, if the document might
need to be viewed or worked on on a different platform.

Switching between the character sets of the different languages supported by OpenType fonts can be as

Note: The most common Mac-specific characters are the fi
and fl ligatures, and some mathematical symbols, particularly those commonly substituted from the “Symbol” font.
The most common Windows-specific characters are the 1/4,
1/2 and 3/4 fractions, and the superiors 1, 2 and 3.
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Application Support for
Advanced OpenType Features
Characters and Glyphs
The distinction between characters and glyphs is central
to a discussion of advanced OpenType layout feature
support. Characters are the code
points assigned by the Unicode
standard, which represent the
smallest semantic units of language, such as letters. Glyphs are
the specific forms or shapes that
those characters can take in a font.

a➔a
a➔A
a➔a

A key point is that one character may be represented by
any of several different glyphs. For example, lowercase
“a,” small cap “a” and an alternate swash lowercase “a” are
all the same character—namely the lowercase “a”—but
they are three separate glyphs.
Additionally, although the relationship between glyphs
and characters is often one-to-one, it may be manyto-one, one-to-many, or many-to-many. For example,
sometimes several characters may be represented by
one glyph, as in the case of the “ffi” ligature, which corresponds to a sequence of three characters: f, f and i.
Alternately, one character may be represented by several
glyphs. For example, “é” is often considered a single
character, but might be assembled on the fly from separate glyphs for the base character and the accent.
OpenType layout features can be used to position or
substitute glyphs. For any character, there is a default
glyph and positioning behavior. Applying layout features to one or more characters may change that default
positioning or substitute a different glyph. For example,
the application of the “small capitals” feature to the “a”
would substitute the small cap “a” glyph for the usual
lowercase “a” glyph.
OpenType layout features
To access alternate glyphs or apply alternate positioning
with an OpenType font, an application must understand
OpenType layout features and present a user interface
that allows end users to select and apply different layout
features to text.

Operating System Support for
Advanced Layout Features
It is much easier for third parties to support advanced
layout features of OpenType on operating systems that
offer such support.

Mac OS X
Mac OS X 10.4 and higher offers OpenType layout
support to applications that use the Apple Advanced
Typography (AAT) programming interfaces, such as
Pages and Keynote. The OS X support of advanced
OpenType layout features is generally limited to western-language features, and does not include contextual
features such as contextual alternates and contextual
ligatures.
Windows
Previous versions of Windows have offered some OpenType layout feature support via Uniscribe (for advanced
typographic features needed for language support) and
OpenType Layout Services (OTLS, an optional component available separately from Microsoft).
At the same time as Windows Vista, Microsoft has
launched a new mode for applications called “Windows
Presentation Foundation” (WPF) which is available
to both Vista and XP applications. Applications using
WPF can easily support a wide range of OpenType typographic functionality. However, applications must be
written specifically to take advantage of WPF. At this
time, few major WPF applications are available.

OpenType and Adobe Applications
Current and recent versions of InDesign, Illustrator and
Photoshop all provide OpenType layout feature support
(see pages 9-12 for feature descriptions, and p. 13 for features by application and application version). With these
OpenType savvy applications, you can turn on OpenType layout features that automatically substitute alternate glyphs in an OpenType font, such as automatic
ligatures, small capitals and proportional oldstyle figures.
This support simplifies the use of professional typographic features once considered cumbersome, and providing exciting new typographic capabilities.
Those layout features that have some effect even on non
OpenType fonts (such as all caps, small caps, and ligatures) are on the main flyout from the InDesign character palette. However most OpenType layout features are
accessed either by the OpenType sub-menu of the character palette flyout (for InDesign) or from the OpenType Palette (for Illustrator CS, CS2, CS3 and CS4). The
many OpenType formatting options are discussed in
detail below.
To gain a better understanding of the features supported
in each OpenType font, in InDesign or Illustrator CS/
CS2/CS3/CS4 you can use the Glyph Palette to view the
glyphs available for each feature (see section below).
Remember that not all fonts have all OpenType layout
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features, and that some features may work only on certain
characters.
There are three features which may have an effect on
non-OpenType fonts, but do more with OpenType fonts
that have relevant layout features. These features—ligatures (which are on by default), all capitals, and small
capitals—are directly accessible from the main flyout of
the InDesign character palette.
In InDesign 2.0, these typographic features were
included on the main pop-up menu because they can
sometimes be used with non-OpenType fonts. See the
individual feature descriptions for details.
Note: In Adobe applications, selecting the Superscript and Subscript options on the Character palette’s
main flyout will create these glyphs by scaling full-size
numbers, even if the selected font contains designed
superscript/subscript glyphs. To access designed glyphs
contained in an OpenType font, you should instead use
the “Superscript/Superior” and “Subscript/Inferior” features on the OpenType flyout menu or palette. See the
OpenType layout features glossary below for details.
To apply OpenType layout features in
InDesign or Photoshop
1 Insert your cursor in a text box to apply the feature
to new text, or select existing text you wish to format.
2 Select an OpenType font from the Character palette
or via the Type > Font menu.
3 In the Character palette, click on the button near
the top right corner of the palette to open the flyout
menu that lists possible formatting options. In
Adobe CS2 and earlier applications (below, top), this
is a triangular button; in CS3 and CS4 (below, center
and bottom) it became a very small downwardspointing triangle with lines next to it.

A check mark will appear next to a feature that is
turned on. If the OpenType font has the desired feature and glyphs, it will be applied. Remember that
not all fonts have all OpenType layout features, and
that some features work only on certain characters.
For example, text with the “Discretionary Ligatures”
feature turned on might automatically replace certain character combinations such as “ct” or “st” with
a ligature such as “ct” or “st.”
If an OpenType layout feature appears in square
brackets [like this], then the currently selected font
does not support that particular feature.
A dash next to an advanced OpenType layout feature
means that you have selected a block of text that has
an OpenType layout feature applied to some of the
text. A check mark will appear next to a feature that
is turned on for all the selected text.
To apply OpenType layout features
in Illustrator CS through CS4
1 Insert your cursor in a text box to apply the feature
to new text, or select existing text you wish to format.
2 Select an OpenType font from the Character palette
or via the Type > Font menu.
3a As described and shown above for InDesign and
Photoshop, in the Character palette, click on the
symbol in the top right corner of the palette to open
the flyout menu that lists possible formatting options.
Select a formatting item on the main flyout that
may activate OpenType features, such as All Caps or
Small Caps.

4 Either select a formatting item on the main flyout
that may activate OpenType features, or (in InDesign
only) select the OpenType sub-menu, and a formatting option on that sub-menu.

A check mark will appear next to a feature that is
turned on. If the OpenType font has the desired feature and glyphs, it will be applied.
OR
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3b Use the OpenType Palette (which can be found
grouped with the character and paragraph palettes)
to select desired features.
Features may be turned on with the selection boxes
(for figure type and position) and the icons (for all
other features). The selection boxes show the current
state of the figure type and position. Features that
have icons and are turned on are highlighted in the
palette. Icons cannot be selected when they are not
supported in the currently selected font; the cursor
will turn into a “no entry” symbol when placed over
such an icon.

OpenType layout features glossary
Below are descriptions of the OpenType layout features
supported by Adobe applications, and guidance on how
and when to use these features. See the last page for
details on which applications support which features.
Some effects similar, but inferior, to OpenType layout
features can be created synthetically by scaling, and
sometimes repositioning, regular-size glyphs. Because
these effects do not use real, designed glyphs, these
are referred to as faux effects (“faux” is a French word
meaning “false”). Layout features which may have
faux equivalents include small caps, fractions, ordinals,
Figure Type:
Default
Tabular Lining
Proportional Lining
Proportional Oldstyle
Tabular Oldstyle

Figure Position
Default
Superscript/Superior
Subscript/Inferior
Numerator
Denominator

you should access real designed glyphs via OpenType
layout features.
All Caps: With both OpenType and other fonts, this
function formats the text in uppercase. With OpenType
fonts, it also applies OpenType layout features for alternate uppercase positioning of punctuation, and spacing
designed for all-cap use.
typed uppercase
formatted all caps

¿QUE? ‹ROMA-PARIS› (I)
¿QUE? ‹ROMA-PARIS› (I)

Small Caps: With both OpenType and other fonts, this
formats lowercase text as small caps. (Note: compare
with “All Small Caps” feature below.) If the font has
OpenType small caps, these will be used. If the font has
a companion Expert Set font, InDesign may be able to
tell that the font is associated with the base font, and
use the small caps from the Expert font. For other fonts,
either small caps will not work, or the application will
synthesize small caps from capital letters. Observe how
these “faux” small caps look light and spindly next to
the capitals, while the designed small caps match the
appearance of their full-size siblings.
faux small caps
real small caps

Life Is But A Poor Player
Life Is But A Poor Pla

Ligatures: This activates any standard ligatures in an
OpenType font (ligatures that the type designer suggests should be customarily used). In an OpenType
font, these can be any ligatures the type designer chose
to create. The major reason for standard ligatures is to
avoid awkward collisions between letters, creating more
elegant text (see example below). Standard ligatures are
on by default in Adobe applications that support them.
In non-OpenType fonts, InDesign (only) will still activate any of the basic f-ligatures that are in the font. In
many fonts, this is only the fi and fl ligatures, though
InDesign may also recognize the ff, ffi and ffl ligatures if
they are present.

								
Fractions
							
Ordinals
						
Titling Alternates
					
Stylistic Alternate (#1)
				
Swash
			
Discretionary Ligatures
		
Contextual Alternates
Standard ligatures
superscript/superior, subscript/inferior, numerators and
denominators. For the best results, whenever possible

Many Adobe Pro fonts include a large set of standard
ligatures, such as fi, fl, ffi, ffl, ff, fj, ffj, Th, and others.
Most other OpenType fonts from Adobe have at least fi
and fl, and some have fi, fl, ff, ffi and ffl.
without ligatures
with ligatures

This office fjord aſſign
This office fjord aſſign

Discretionary Ligatures: In supporting Adobe applications, this activates discretionary and historical ligatures, both of which should be used sparingly for special
effects. These ligatures may include ct, sp, ﬆ, and several historical “long s” ligatures such as ſh. Only some
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OpenType fonts have discretionary and historical ligatures.
without disc. lig.
with disc. lig.

Most effects
Most effects

Fractions: Turns on fractions. Some OpenType fonts
from Adobe only have three basic pre-built fractions
(1/2, 1/4, 3/4), while others have a larger set, often including
1/8, 3/8, 5/8, 7/8, 1/3 and 2/3. The extent of pre-built fractions
may vary between fonts. Select OpenType fonts can also
support any arbitrary fraction such as 11/12 or 7,402/12,597.
In all these cases, these designed fractions match the
weight of the rest of the font better than fractions which
are fauxed by scaling regular-size numbers.
Note: You should only apply the fraction feature to the
specific text you want to turn into a fraction. Applying the fraction feature to other numbers may result in
unexpected effects—either initially, or later if the text is
switched to a different or just newer font, with a different
implementation of fractions.
faux fractions
real fractions

11⁄8 31⁄2 22⁄7 511⁄12 81,234⁄4,567
11/8 31/2 22/7 511/12 81,234 /4,567

Ordinals: Switches regular glyphs to designed superscripted glyphs, such as the “st”’ in 1st, “nd” in 2nd, and
so on. Virtually all Adobe fonts have the masculine
and feminine ordinals required for Spanish segunda/
segundo (2a, 2o), but not all have the full set of superscripted glyphs needed for English ordinals. In OpenType fonts from Adobe, the № (number) character and
the “h” required for ordinals such as “4th” are generally
present only in Pro fonts. Some Adobe Pro fonts also
have the superior “g” and “é.”
Some applications, such as word processors, can automatically synthesize ordinals by scaling regular letters. As always, real designed ordinal glyphs are a better
match for the full-size numbers than the faux ordinals
created by simple scaling.
faux ordinals
real ordinals

1st 2nd 3rd 4th 2a 2o
1st 2nd 3rd 4th 2a 2o

Note: Like fractions, the ordinal feature should not be
applied globally, but only where needed. Some fonts may
use contextual rules to implement ordinals, while others
will turn them on for all selected text. Also, ordinals
work best with lining figures, rather than oldstyle figures,
because of the constant vertical position of the ordinals.
Swash: Substitutes swash glyphs (stylized letterforms
with extended strokes; see below). Even if this feature is
globally turned on, it may only apply swashes in certain

cases, such as when a character is at the end of a word.
Swashes should be used sparingly for special effect.
Only some OpenType families contain swash glyphs,
and in families which do contain swash glyphs, they are
often present only in the italic faces within the family.
without swash
with swash

Aidan Sue Veronica
Aidan Sue Veronica

Titling Alternates: Substitutes specially-designed
glyphs to be used for large-size settings such as titles,
usually all in capitals. Only some OpenType fonts from
Adobe have titling alternates. Having a separate “display”
typeface with a full character set is sometimes an alternative to titling alternates (see p. 3).
without titling
with titling

FINESSE BEAUTY
FINESSE BEAUTY

Contextual Alternates: In supporting Adobe applications, this substitutes both alternate glyphs and ligatures
that only occur depending on what letters are nearby.
This feature is on by default in InDesign and Illustrator.
Contextual forms can have striking effect in those select
OpenType fonts that make use of them. For example,
Caflisch Script Pro uses contextual forms to create variety and a realistic calligraphic handwriting appearance.
without contextual
with contextual

new azaleas bloom where
new azaleas bloom where

All Small Caps: Unlike the traditional small caps feature, which turns only lowercase into small caps, this
substitutes small capitals for all characters typed or
selected—both uppercase and lowercase letters.
“All small caps” should be used instead of “small caps”
whenever the underlying text is uppercase, as with certain acronyms and abbreviations such as USA, UNICEF,
FBI, GDP or MADD. (See also “Small Caps,” previous.)
Stylistic Alternates: Substitutes the first stylistic alternate (if there is one) for the selected glyph(s). Stylistic
alternates is a feature for stylistic variations that are not
covered by other features, and do not affect the entire
font. Although it is possible to have more than one stylistic alternate for a given character in a font, Adobe’s
current approach accesses only the first one. The example below shows stylistic alternates from several different fonts.
without
with stylistic alts

& aEGMR βθφπκ
& aEGMR ϐϑϕϖϰ

OpenType User Guide

Stylistic Sets: Replaces some specific glyphs within
the selected text with other specific glyphs, intended
to achieve a particular overall change in appearance
for the text. One font may have multiple stylistic sets,
and the effects may be cumulative, either on the same
characters or different ones. The effects of stylistic sets
are essentially arbitrary and are likely to vary dramatically from one typeface to another. In the example
below with Poetica, Stylistic Set 2 affects the lowercase,
while the other 12 stylistic sets create increasing levels of
swashiness with the capitals.

This is Poetica with Stylistic Sets
This is Poetica with Stylistic Sets
stylistic set 2
This is Poetica with Stylistic Sets
stylistic set 1
stylistic sets 2+4 This is Poetica with Stylistic Sets
stylistic sets 2+10 This is Poetica with Stylistic Sets
default forms

Slashed Zero: Substitutes a slashed form of the zero (if
there is one) for zeros in the selected text. Even if the
font has a slashed zero, it may not have it for all forms
of the zero (e.g. proportional, oldstyle, superscript, etc.).
The example below shows slashed zeros from several
different fonts.
without
with slashed zero

000000
000000

Superscript/Superior: Substitutes designed superscripted glyphs. These designed glyphs match the weight
of the regular letters and numbers better than synthesized (faux) superscript glyphs. Note that the select
OpenType fonts from Adobe which support this feature
do not have all characters available in superscript form.
Instead, they generally have the letters “abdeilmnorst,” plus
a full set of numbers and basic punctuation. Pro fonts
generally add the “h” as well. This subset of the alphabet represents all the characters needed for ordinals and
common superscripting needs in western languages.
faux superscript
real superscript

x14y37 πr2 4a
x14y37 πr2 4a

Subscript/Inferior: Much like superscript (above), but
for subscripted characters. However, the select Adobe
fonts which support subscripts generally have only
numbers and punctuation, with no letters.
faux subscript
real subscript

H2O CH4 n37
H2O CH4 n37

Numerator: Substitutes designed numerator glyphs (the
top part of a fraction) for numbers. Those OpenType
fonts from Adobe that support this feature generally
have a full set of digits and basic punctuation in numerator form. However, it is generally more convenient to
simply apply the fraction feature.
Denominator: Just like numerators, but for denominators (the bottom part of a fraction).
Figure (number) Types: Tabular figures are all of equal
width. They are only needed when the figures must all
line up from one line to the next, as in a table. Proportional figures have varying widths, just like most letters; each number has a width appropriate to its design.
Unless there is a special need for tabular figures, you
should use proportional figures.
Lining figures are all the same height, usually similar to
that of capital letters. They are needed for use with allcapital settings, or when a particularly modern look is
desired. Oldstyle figures are of varying height. They are
appropriate for use with lowercase or mixed-case text,
and especially if a classic or refined look is desired.
Figure Types

lining

tabular

0123456789 0123456789
0123456789 0123456789

proportional

oldstyle

Default figures are whichever type are encoded as the
standard figures in the font. For historical reasons, these
are usually tabular lining figures in Adobe fonts, though
the decision is up to each font manufacturer. Because
tabular lining figures are rarely the best choice for a
document, we recommend actively choosing figure
types for each particular usage. Proportional oldstyle
figures are a good default for normal mixed-case text.
Mark Attachment: Applications with this capability support fonts that have separate marks (accents
etc.) and base characters, and can dynamically attach
separate marks to base letters. This allows font developers to make fonts with fewer glyphs, and is also a basic
requirement for supporting some complex languages.
Positional Forms: Enables glyphs to take different
shapes depending on whether a letter is by itself, or
in a beginning, middle or ending position in a word.
Required for certain non-Latin languages such as
Arabic, but also enables better behaviors for “script”
style fonts in English and other western languages.

The Glyph Palette
While OpenType layout features are primarily accessed
via the OpenType palette (Illustrator) or the OpenType
flyout of the Character palette, Adobe InDesign (all
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versions) and Adobe Illustrator CS–CS4 also allow you
to view and access all of the possible glyphs and layout
features in an OpenType font through the Glyph Palette.
Show OpenType layout features

Alternate glyph
indicator

You can view only the alternate glyphs available for
a single selected glyph in
your InDesign document
by selecting “Alternates for
Selection” from the “Show”
pop-up menu of the Glyph
Palette. (If more than one
glyph is selected, the Glyph
Palette will show no alternates.)
Adobe applications remember the last OpenType
layout feature you used the
next time you activate the
Glyph Palette. To return to
a view of all the glyphs in
the font, select Entire Font
from the pop-up menu.

Family selection field
Style selection field
Glyph selection flyout
Decrease/increase
display size
1 Insert your cursor in a text box.
2 Select Type > Insert Glyphs… The Glyph Palette will
appear.
3 Select a font in the font selection field. Select the
appropriate font weight or style in the style selection
field. All of the possible glyphs in the font will appear.
You can also click on the size icons to increase or
decrease the point size of the glyph samples in the
window.
If there are alternate forms of a glyph available via an
OpenType layout feature, a small triangle will appear
in the lower right corner of the glyph cell. Clicking
and holding on such a glyph cell will activate a flyout
showing all the alternate glyphs.
4 Double click on a glyph cell, or if there is a flyout,
click-hold and select the desired alternate glyph. The
glyph will then be inserted in your document wherever your text cursor was positioned.
You can filter the glyphs displayed in the dialog by
using the OpenType layout features pop-up menu. This
pop-up menu will display all of the substitution features
supported by the currently selected OpenType font.
After choosing an OpenType font in the font selection
field, select a layout feature, such as discretionary ligatures or swash, from the pop-up menu and the dialog
will display only those glyphs that are available through
that layout feature.

For more information about the Glyph Palette, please
refer to the Illustrator or InDesign User Guide, as
appropriate.

Customer care
Customer Service
Adobe Customer Service provides assistance with product information, sales, registration, and other nontechnical issues. To find out how to contact Adobe
Customer Service, please visit Adobe.com for your
region or country and click on Contact.
Support Plan Options & Technical Resources
If you require technical assistance for your product,
including information on free and paid support options
and troubleshooting resources, more information is
available at http://www.adobe.com/go/support/. Outside of North America, go to http://www.adobe.com/
go/intlsupport/. Free troubleshooting resources include
Adobe’s support knowledgebase, Adobe user-to-user
forums and more.
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Appendix: OpenType Layout Feature Support by Application
InDesign® CS3/CS4

InDesign CS2

Illustrator® CS–CS4

Photoshop® CS–CS4

InDesign 2/CS

InDesign 1.x

OpenType Layout
Feature Codes

Flash® Player 10

Photoshop 6/7

User Interface Label
Font metrics kerning

kern

•

•

•

•

•

•

•

•

Oldstyle (proportional oldstyle)

pnum + onum

•

•

•

•

•

•

•

•

Ligatures

liga

•

•

•

•

•

•

•

•

Discretionary Ligatures

dlig + hlig

•

•

•

•

•

•

All Caps

case, cpsp

•

•

•

•

•

•

•

•

Small Caps

smcp

*

•

•

•

•

•

•

•

All Small Caps

smcp + c2sc

*

•

•

All Alternates (via glyph palette)

aalt

•

•

•

•

•

Glyph Palette

most other features (via filters)

•

•

•

•

•

Tabular Lining

tnum + lnum

•

•

•

•

•

Proportional Lining

pnum + lnum

•

•

•

•

•

Tabular Oldstyle

tnum + onum

•

•

•

•

Fractions

frac

•

•

•

•

•

Ordinals

ordn

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

Titling Alternates

titl

Swash

swsh + cswh

Contextual Alternates

calt + clig

Superscript/Superior

sups

•

•

•

•

Subscript/Inferior

subs if present, else sinf

•

•

•

•

Numerator

numr

•

•

•

•

Denominator

dnom

•

•

•

•

Stylistic Alternates

salt (first alt only)

Ornaments

ornm (first ornament only)

•

Stylistic Sets (1-20)

ss01-ss20

•
•
•

•

•

•

•

Slashed Zero

zero

•

(no UI) Mark Attachment and
language-specific processing

mark, mkmk, mset,
locl, rlig, ccmp

•

•

Positional Forms

init, medi, fina, isol

•

•

* Flash Player 10 does small caps and all small caps by means of case conversion plus ‘c2sc’.
Fireworks CS4 supports OpenType layout features, but only in text pasted from Illustrator or Photoshop.
© 2000–2005, 2007, 2008 Adobe Systems Incorporated and its licensors. All rights reserved. Created in Adobe InDesign with OpenType fonts from Adobe.
Adobe OpenType User Guide v37, 07 October 2008
This manual, as well as the software described in it, is furnished under license and may
be used or copied only in accordance with the terms of such license. The content of this
manual is furnished for informational use only, is subject to change without notice, and
should not be construed as a commitment by Adobe Systems Incorporated. Adobe Systems
Incorporated assumes no responsibility or liability for any errors or inaccuracies that may
appear in this book. Except as permitted by such license, no part of this publication may
be reproduced, stored in a retrieval system, or transmitted, in any form or by any means,
electronic, mechanical, recording, or otherwise, without the prior written permission of
Adobe Systems Incorporated.
Adobe, the Adobe logo, Adobe Garamond, Adobe Type Manager, ATM, Caflisch Script,
Calcite, Illustrator, InDesign, Lithos, Minion, Myriad, the OpenType logo, Photoshop,
PostScript and Silentium are either registered trademarks or trademarks of Adobe Systems
Incorporated in the United States and/or other countries. Apple, Macintosh, Mac OS,
Power Macintosh, and TrueType are trademarks of Apple Computer, Inc., registered in the

U.S. and other countries. PowerPC is a registered trademark of IBM Corporation. Pentium
is a registered trademark of Intel Corporation. Microsoft, Windows, Windows NT and
OpenType are either registered trademarks or trademarks of Microsoft Corporation in
the U.S. and/or other countries. All other trademarks are the property of their respective
owners.
Adobe Systems Incorporated, 345 Park Avenue, San Jose, California 95110-2704, USA.
Notice to U.S. government end users. The software and documentation are “commercial
items,” as that term is defined at 48 c.f.r. §2.101, consisting of “commercial computer
software” and “commercial computer software documentation,” as such terms are used in
48 c.f.r. §12.212 or 48 c.f.r. §227.7202, as applicable. Consistent with 48 c.f.r. §12.212 or 48
c.f.r. §§227.7202-1 through 227.7202-4, as applicable, the commercial computer software
and commercial computer software documentation are being licensed to the U.S. government.

13

